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KNIME SOP

This SOP is intended as a general guide to help beginners get started with the software. It details: the
installation process of KNIME and basic extensions; setting up the workspace in logical manner; how
to import and use existing workflows (e.g. a bespoke PAINS filter that can be modified to suit the needs
of a project); and finally general and more advanced knowledge on how to use KNIME.

Downloading the software
1. Visit the KNIME website (https://www.knime.com/)
2. Click the download icon in the top right corner:

Hub Blog Forum Events Careers Contact Download Q

SOFTWARE / SOLUTIONS / LEARNING / PARTNERS / COMMUNITY / ABOUT

a. Fill out registration details (only email is compulsory) and then click submit

Open for Innovation Hub Blog Forum Events Careers Contact Download Q

KNII IE SOFTWARE / SOLUTIONS / LEARNING / PARTNERS / COMMUNITY / ABOUT

Home
1 © Download KNIME @) Get Startec

New to the KNIME family? Let us help you get started with a short series of introductory emails. These messages will get you up and running as quickly as
possible and introduce you to resources that will maximize your success with the KNIME Analytics Platform.

First Name
Last Name
E-Mail
Country

b. Download appropriate version. For windows select the 64 bit installer:

KNIME Analytics Platform for Windows (installer) 54 Bit  (441.03 MB)
The installer adds an icon ta the deskiop and suggests suitable memory settings 32 Bit  (437.42MB)

c. Accept and download (takes a few minutes):


https://www.knime.com/

Holly Foster 315 March 2020 Version 1.0

Open for Innovation

KNIME

Home > Downloads

Download Q

SOFTWARE / SOLUTIONS / LEARNING / PARTNERS / COMMUNITY / ABOUT

You decided to download the installer for KNIME Analytics Platform for Windows (installer) 64 Bit (441.03 MB).
The installer adds an icon to the desktop and suggests suitable memory settings

If you want to run the KNIME installer or self-extracting archive for Windows you might experience some difficulty because of the Microsoft SmartScreen filter
which was introduced with Internet Explorer 9 and Windows 8.

| have read and accept the and the
@® Download
d. Allow app to make changes to your device
e. Acceptthe agreement
f.  Choose location to install KNIME (click next)
g. Start menu folder — either click next or choose not to have this
h. Additional tasks — make sure file extensions and URLs are all ticked
i. Proceed with suggested memory space
j.Install
k. Finish

3. Launch KNIME (either from desktop icon if you selected that or type ‘KNIME’ in the computer
search bar)

a. The platform launcher should pop up, and click launch:
KMNIME Analytics Platform Launcher >

Select a directory as workspace

KMIME Analytics Platform uses the workspace directory to store its preferences and development artifacts.

Workspace: | ChUsers\Holly'\knime-workspace ~ Browse...

[] Use this as the default and do not ask again

» Recent Workspaces

Tidying the workspace for efficient working
Once set up these modifications should be retained every time KNIME is launched. This is not the only
way to configure the panel set up, but | find it most useful as gives the most space for the workflow.

1. Close workflow coach (use the cross):
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KNIME Analytics Platform

- X
File Edit View Help
=
£ KNIME Explorer 53 = B | Welcome to KNIME Analytics Platform 53 = B | Ly Description 3% L [m]
BEEBsS V| B
5 L My-KNIME-Hub (hub.knime.com) KNIME
> 4 EXAMPLES (knime@hub knime.com)
v £ LOCAL (Local Workspace) A
> [ Example Workflows Welcome
£ Workflow Coach 53 B =0
Node recommendations only available with usage data reporting. ° ="}
i o Get started Find many more Guided onboarding
>
5 & Manipulation Learn from a pre-built examples Sign up for intro emails to get
. & workflow. KNIME Hub s the easiestway  Up and running as quickly as
5 @ Analytics to share, browse and execute possiole.
= Knowiedge
r= gfherbmwes knowledge | 4 KNIME Hub Search 22 =g
R ’—|
> <> Structured Data M. o (e 1 - ’ i
> & Scripting 9z Outline 3 = O B Console 32 RER #B-3-=08
5 3§ Tools & Services
© B KNIME Labs An outline is not available. KNIME Console
4 :‘%WO’ﬂlowcontrOI_ i Welcome to KNIME Analytics Platform v4.1.2.v202003050920 —
% (4 Wodkliow Bbstiaction wxe Copyright by KNIME AG, Zurich, Switzerland s
> &) Reporting
Log file is located at: C:\Users\karl\knime-workspace\.metadata\knime\knime.log
Done ‘ Installing Software: (49%) E

2. Drag Node Repository next to KNIME explorer:

KNIME Explorer £3
pl
BB

YA
NN

=

Y

> dog My-KNIME-Hub (hub.knime.com)

> Q EXAMPLES (knime@hub.knime.com) 4

v 4 LOCAL (Local Workspace)
> [*] Example Workflows

Q views

¥ Analytics

S DB

> °§ Other Data Types

<> Structured Data

» @ Scripting

» 3y Tools & Services

#§ KNIME Labs

> ._v; Workflow Control

S — Y -

i g4 = > A Workflow Abstraction
, 10

." Manipulation

Q Views

> @ Analytics

, S DB

5y Other Data Types

» <> Structured Data

» @ Scripting

. = Reporting

3. Close KNIME hub search
4. Close Outline
5. Drag ‘Console’ and ‘Description’ to bottom left of the screen

Window should look like this upon completion:
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KNIME Analytics Platform - X
file Edit View Help

(57 Quick Access

4 KNIME Explorer 53 4

B BB

= 8 @ Welcome to KNIME Analytics Platform 53 = 8

N o .
L My-KNIME-Hub (hubknime.com) KNIME

A EXAMPLES (knime@hub.knime.com)
v 4 LOCAL (Local Workspace)
[ Example Workflows

Welcome

1OUE Cammmty Wk Som s

) Console 53 Ly Description = )
ST
KRIME Conole Get started Find many more examples Guided onboarding
I
e Welcome to KNIME Analytics Plati Learn from a pre-built workflow KNIME Hub is the easiest way to share, browse Sign up for intro emails to get up and running as
o Copyright by KNIME AG, Zur and execute kn: quickly as possible.

Log file is located at: C:\Users\karl\knime-

Installing chemistry extensions
1. File > Install KNIME Extensions

KMIME Analytics Platform
File Edit View MNode Help

T MNew.. Ctrl+N
Save Ctrl+S
[5] Save As...
Save All Ctrl+Shift+5
Close All Ctrl+Shift+W
Recent Workflows ¥

Print... Ctrl+P
Import KNIME Workflow...

Export KMIME Workflow...

Export to SVG...

% b b €

Switch Workspace »

Preferences

-

i

Export Preferences...

Import Preferences...

Install KNIME Extensions...
Update KNIME...

Restart

Exit

2. Select extensions of interest using the tick boxes. The cheminformatics and Marvin chemistry
extensions are recommended as a minimum:
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type filter text

Name

[ too
[ ooo
[ too
> uoo
[ too
» []0oo
[ too
» []ooo
[ too
[] ooo
[ too
> uoo

KNIME & Extensions

KNIME Big Data Extensions

KNIME Community Extensions - Bioinformatics 8 NGS

KNIME Community Extensions - Cheminformatics

KNIME Community Extensions - Image Processing and Analysis
KNIME Community Extensions - Other

KNIME Community Extensions Sources

KNIME Labs Extensions

KNIME Node Development Tools

KNIME Partner Extensions

KNIME Server Extensions

Marvin Chemistry Extensions (donated by Infocom & Chemaxon)

Select All Deselect All 10 items selected

Details

Show only the latest versions of available software

Group items by category

[] Show only software applicable to target environment

Version

3. Click next and then next, accept agreements, finish
4. Close KNIME and restart for changes to take effect

5. Other extensions can be added by clicking Help > Install New Software:

KMIME Analytics Platform
File Edit View MNode Help

Hwiihg

A KNIM... 52
SH=N

(& | 100% (7) Help Contents
& Search

Welcome Page

Documentation

oz My-KNIME-Hub

Ay EXAMPLES (knirr

v A LOCAL (Local Wi

D Example Wor Cheat Sheets...

About KNIME Analytics Platform
. Lk Install New Software...

Show Active Keybindings...

=1 rEwl [

Hide items that are already installed

What is already installed?

6. Type in web address for new extension in the ‘work with’ section then click ‘add’
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Install ] x
Available Software
Select a site or enter the location of a site. J K
Work with:ﬂ a

type filter text

Add...

Manage...
Name Version
] (@ There is no site selected.
Select All Deselect All
Details
Show enly the latest versions of available software Hide items that are already installed
Group items by categery ‘What is already installed?
how only software applicable to target environment
Contact all update sites during install to find required software
< Back Next > Finish

Cancel
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Basic KNIME knowledge

Headed arrows show the data inputs/outputs from nodes:

RDKit From Molecule

B 3 >
-
Mode 110

Running nodes: right click > execute or execute and open views to see the output of this node.
Alternatively select then hold fn and f7.

E) Configure... F6
() Execute F
| " Bl Execute and Open Views Shift+F10

A &Y-DI0e Cancel F9 5,
[?4 Reset F8
= Edit Node Description... Alt+F2
=l New Workflow Annetation
D'j Connect selected nodes Ctrl+L
Dr" Disconnect selected nodes Ctrl+Shift+L
[E] Creste Metanode...

: ofinterest. Ide Create Component..

1eet. @ View: Structures

antial modifcatit 57 Compare Nodes

thatthe input
15ists of two col
1d SMILES prior
ative spreadshi °f  Cut
may need B Copy

Show Flow Variable Ports

at you have the Paste
Sttt & Undo
Redo
—— 3 Delete
String to M itri
= E Converted Data
» = »
= 2 g
Node 109 MNode 108 Node 110 MNode 10«

Viewing node outputs: right click and then select the bottom option that has a spreadsheet
and magnifying glass
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WL E IR R L = FUAIRIE At | laimn Db aensnan o

E Configure.., F&

Execute F7

0 Execute and Open Views Shift+F10

t Cancel Fa

v FE  Reset F8

y = Edit Node Description... Alt+F2
1 =l  Mew Workflow Annotation

( Connect selected nodes Ctrl+L

Disconnect selected nodes Ctrl+Shift+L

Create Metanode...

!ﬁnﬂuﬂ

Create Component...

'
[ Q? Compare Nodes
Show Flow Variable Ports
Tof Cut
(5 Copy
Paste
<< Undo
Redo
W Delete
E COutput data

Erroneous input data

e Searching for nodes: Navigate to the node

repository and type a key word in the search bar

(e.g. filter), or navigate manually (e.g. to find column filters: manipulation > column > filter)

A KN

E Explorer £ Node Repository

A —

v .‘4 Manipulation A

Column
w [ Filter
ili Column Filter
¥ Reference Column Filter
T: Constant Value Column Filter
% Missing Value Column Filter
3* Reference Column Splitter

w W

=8 A

E Explorer _‘f Node Repository

= 0
L]~

&y 10
& Manipulation

v Column

™ Binning

[*] Convert & Replace

~ [ Filter
ili Column Filter
1* Reference Column Filter

w Row T! Constant Value Column Filter
[™] Filter B Missing Value Column Filter
™7 PMmML 35 Reference Column Splitter
@ Analytics [*7] Split & Combine
- n N 1 Teancfarm v
e Connecting nodes: Drag inputs/outputs from one node to another
Excel Reader (XLS) String to Molecule
e —
‘:"‘i —_ L el
]
Mode 106 Mode 109
o Node traffic lights:
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Understanding the traffic light system:

® Not configured: Node is not yet configured and
cannot be executed with its current settings

Configured: Node has been correctly configured
and may be executed at any time

@ Executed: Node has been successfully
executed and results can be viewed and used in
downstream nodes

e Node errors are denoted with a warning triangle. If you hover over this it will detail the issue.
The console may offer further description of the problem.

Excel Writer (XLS) Excel Writer (XLS)
L3 -
MNode 105
Mode 103 [ .1 The path must be absolute. |
A Description B Console 53 EEEE B~ -= 0O

KMIME Console

Fkkkdkkkfkkkdkk kR kb kkkkkdk kb kkk ks kk ki
il Welcome to KNIME Analytics Platform wv4.1.1.v282¢
ww Copyright by KNIME AG, Zurich, Switzerlanc

dkkkkkdkkkbkbkkkhhbkkkbkkkhkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkdkkd

Log file is located at: C:\Users\Holly\knime-workspace’.met:

WARN  Excel Writer (XLS)  @:185 The path must be abscl
ERROR RDKit Functional Group Filter 9:73 Could not st
ERROR RDKit Functional Group Filter 8:78 Could not stc
WARN Excel Writer (XLS) @:185 failed to apply settir
WARN Excel Writer (XLS) @:185 The path must be abscl
WARN  Excel Writer (XLS) @:185 The path must be absol
WARN Excel Writer (XLS)  @:185 The path must be abscl
WARN  WorkflowManager Workflow contains node

e Node descriptions: Click on a node and select the ‘Description’ tab to understand the function

of the node:
@ R B Console = 5 likely to work but ma:
You can check thaty
Excel Reader (XLS) ~
Excel Reader (XLS)
This node reads a spread sheet and provides it at its ouiput port.
It reads only data from one sheet, but it is possible to read multiple files ' I
that contain the same sheet name at once.

It can read only numeric, date, boolean and string data but, of course, no " Node 106
diagrams, pictures, or other items.

Currently supported KNIME ftypes are String, TimeAndDate, Double,

Boolean, and Int.

It reads in the data from the sheet and sets a type for all columns that is

compatible with the data in that column {in the worst case "Siring" covers

all). W

The narfarmance of the reader nndea iz limitad (doue tn the ondarivinn £
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Importing existing workflows

1. File > Import KNIME workflow
2. Browse to select workflow of interest > open > finish
3. Double click workflow on KNIME explorer

Using the PAINS filter
1. Import workflow:

KNIME Analytics Platform
Edit View Mode Help

File

% B €9 &0 b 1

i

New...
Save
Save As...
Save All
Close All

Recent Workflows

Print...

Import KNIME Workflow...
Export KNIME Workflow...
Export to SVG...

Switch Workspace

Preferences
Export Preferences...

Import Preferences...

Install KNIME Extensions...
Update KNIME...

Restart
Exit

Ctrl+M
Ctrl+5

Ctrl+Shift+5
Ctrl+Shift+W

»

Ctrl+P

2. Double click workflow link in the ‘KNIME explorer’:

4% KMIME Explorer &% £ Node Reposit
B B|&
™7 MedChemWizard
[ Tools
7] Training

A% COVID1S_enumeration

A4 GPVI_summary

A KMIME_multiplate_final

L4 KNIME_multiplate_workflow
A% KNIME_project 1_training
A4 Multiplate_assay_basic

£ PAINS filter

A4 ¥-D10_elaboration

ity PAINS filter

3. Double click on Excel reader node:

=

& |

v
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File

XLS Reader Settings  Flow Variables Job Manager Selection Memory Policy
Select file to read: ~

@Fie O Fiesin folder

Read from: Local File System
File: C:\Users\Holly\Desktop\COVID-19'\KNIME property fiter example.xisx v Browse... d

Selected file/folder does not exist or cannot be accessed:
C:\Users\Holly\Desktop\COVID-19\KNIME property fiter example. xisx

Adjust Settings:
Select the sheet to read: v Connect timeout [s]: b=
Column Names:
Table contains column names in row number: |1 (Row numbers start with 1. Mouse over header to see row number.)
Row IDs:

(®) Generate RowIDs (index incrementing, starting with 'Row0’) () Generate RowIDs (index as per sheet content, skipped rows will increment index)

EJLI:E' Re\ader {KLE‘} (O Table contains row IDs in column: |4

Select the columns and rows to read:

Make row IDs unique

LS P Read entire data sheet, or ... read columns from: |A to:
-+

- and read rows from: | 1 to:

Tip: Mouse over the column and row headers in the “File Content” tab to identify cell coordinates

On evaluation error:

N o dE 1 [‘] E (@ Insert an error pattern: | #XL_EVAL_ERROR#

(O Insert a missing cell

a. ‘Browse’ to the spreadsheet of interest
b. If you scroll down you can see a preview of what the spreadsheet will look like. Make
sure this looks reasonable. Ideally the input spreadsheet should have one sheet
consisting of the compound ID and SMILES.
4. Double click on the ‘RDkit functional group filter’ and select the functional groups to REMOVE
then click okay. The pre-selected functional groups are detailed below the node.
Dialog - 0:78 - RDKit Functional Group Filter (Azides, aldehydes) — — m] X
File

Options  Flow Variables Job Manager Selection Memory Policy

Select molecule column
RDKit Mol column: | (& Salt Stripped Molecule v

Select functional group definition file (Optional)
Default Definitions ~ Browse... Load Defaults b

List of available functional group filters

Active Functional Group Qualifier  Count

Acid Chloride = o ~
Aromatic Acid Chloride =
Aliphatic Acid Chloride =

Carboxylic Add =

Aromatic Carboxylic Add =

Aliphatic Carboxylic Add =
Alpha Amino Acid =
Sulfonyl Chioride =
Aromatic Sulfonyl Chloride =
Aliphatic Sulfonyl Chloride =
Amine =

RDKit Functional Cust
Group Filter C

Primary Amine =

Primary Aromatic Amine =

Primary Aliphatic Amine =

—
—P' ﬁ P = Secondary Amine = .

Oooooooooogoom®E

olo|o|e|lo|a|la|la|la|a|e|e|a|a

Recording of first non-matching pattern in new column

[[] Enable recording in the following new column:  |First Non-Matching Pattern

Azides, aldehydes,
boronic acids, acid chlorides,
aliphatic halogen, isocyanates oK Apply Cancel | |®

5. Double click the ‘custom functional group filter’ and select other functional groups that you
wish to remove then click okay:
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Dialog - 3103 - Custom Functional Gro..  — O x
File

Options  Flow Variables Memory Policy  Job Manager Selection

Label

Micheal Acceptor
Nitro

alkene

Thio carbonyl

[] Ester
[] Thiophene

oK Apply Cancel @l

6. Double click on the property filter and set the parameters then click okay:
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Dialog - 00100 - Property Filter — O >
File

Options  Flow Variables Memory Policy  Job Manager Selection

LogP Max Change

Maximum Molecular Weight

F =

Maximum Mumber of Heavy Atoms

-

0=

Max TPSA Change

-

150 -5

Maximum Mumber of Rotatable Bonds

-

10 =

Maximum Mumber of H Bond Donaors

r

s

Maximum Mumber of H Bond Acceptors

-

10 =
Max Fraction Sp3 Change
0.99 1%
QK Apply Cancel (7)

7. Right click on the property filter and click ‘execute’
a. Alternatively can select the node and then press fn > {7
b. The traffic light underneath the node should now be green
8. Double click on the Excel writer, and specify the save location, click okay then run this node
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Dialog - 0:105 - Excel Writer (XLS) - O x
File

Settings  Flow Variables Job Manager Selection  Memory Policy
Output location:

Write to: Local File System -

File: ~ Browse... =

Please specify & location

[[] Overwrite existing file

[] open file after execution
Sheet name

Name of the sheet: |default d

Add names and [Ds
[ add column headers
[[] add row ids

Missing value pattern

|:| For missing values write:

Layout
[] Autosize columns

(@ Portrait () Llandscape  |USLetter 8 1/2x 11in v

(®) Manual Selection () Wildcard/Regex Selection (0) Type Selection
Exclude Incude

Excel Writer (XLS) || v .., T

' No columns i s fist »
»

Y -
Mode 105

oK Apply Cancel @

Advanced KNIME Knowledge
Metanodes

Components (GUIs)

Flow Variables

Useful Chemistry KNIME Knowledge
Glossary

Node A node is the smallest programming unit in KNIME. Each node serves a
dedicated task, from very simple ones - like changing the name of a data
column - to very complex one - like training a random forest.

Training Resources

KNIME offers a number of FREE online training courses: https://www.knime.com/knime-introductory-
course



https://www.knime.com/knime-introductory-course
https://www.knime.com/knime-introductory-course
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KNIME also has three short one page ‘cheat sheets’ which are VERY helpful for new users:

https://www.knime.com/learning/cheatsheets . See below for a sneak preview:

Cheat Sheet: Building a KNIME Workflow for Beginners

Getting started with KNIME Analytics Platform
= Read through the installation guide st er Plot: Represents: inburst Chart: D Stacked Area Chart: Plats.
e comtalation input data mowe as pointe ] Satamn thugh Poultipie nLmarical data
na two dmensionai pot.  * & hierarchy of rings. Each columne on 10p of ach other
= out the 7 things you should do sfter installing iny ring is sliced accarding i uging the previous line as the
KNIME Analytics Platform at {enlumns) nnmew s the meminal values in the U baserelerence The
knimecom/blog/saven-things. plot and graphical 3 conesponding calumn and | between lines are colored [ur
Paeperties con he changed 1o the selected hiesarchy: || easier eompatison. Ti
» Take the E-Leaming Courss. inthe configuation This ie a powerful chart for e commonty used to visisis
S Ry window of interactively in  — multivariate analysis. trending topies.
» Browse workflows, nodes, and components at
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[ Executed: Node has been successhully statistical measures snd Mstograms - Tor b st the end of the whishers - they might rark whese the heights ate prepartionsi 1 the
executed and resulls can be viewed and used in ind nominal columniz. autlers! values. The partitians are defined by a cateqorical
downstream nodes o= om 8 column
~
READ
Fitmin File Reader Reads all text files, ssmman Table Rieader. Reads dota fram a tabile file. Explore
ularly character separated fles, table files are organized using a KNIME e Learner Nodes: Supervised algorithms in
such as CSV files. The File Reader is the: ' praprietary forma, including the full file KNIME Anshytics Platform have & Leamer
werkharse for reading text data Stnicture and are optimized for space and - Pdcne G ta rin & model on a previously labelled
X8 =peed- providing maximum performance with training sel.
Fanieruiens configuration! am
s, Excel Reader (LS): Reads content fram Predictor Nodes: Used for aagying madeis.
sheets in Excel leg (XLS. KLSY). Sheet (00 | T8 Thetw inputs are the
and gy Reads data from a data to process. raulpulummime
configuration window, Goagle Sheet file. Authentication pecurs on onginal data and the model predictions
m [m] » the Google site. Google credentials are not
o Table Crestor: Alomz uoers 1o manually saved wiihin the KIME warkflow
crete a data table inits configueat el Read Transform Anlyze Degloy
E Wi 34 3 data sheat Data Leks can be
‘copied and pasted in the sheet. Perfe knirme.Jf protocol: Relerence a file path relative to
[I8  for generating small data sets. somme key location of the current KNIME inslallatian ike ili
o n pa
models penerar ed h any of the Leamer Er. E- m (n

Version History

©pen for Innavatian

ME

ANALYZE
et Dgcigion Tree: The Leamer node traing a C4.5
decision tree. The configuration window

-. includes options for pruning early i
intommation meaminea. splting et an
OO more. Both the Lesmer and thé Predictor
node provide an interactive view where the
decigion tree iz dizplayed together with the
input data propagation.
lMeans: mplements the kadeans dlustering
Humber of chusters must
pmu o node enecation. This node bullda the
clusters. The Cluster Assigner node finds the
clasest eluster and sssigns (116 the input
data row. Being an unsupervised algorithm,
this nocle pair doesnt Tallow the classie
Learner - Predictor scheme.

LogisicRigression The Lesener node trins &
logietic regrassion model to predict categoncal
tafget values, Themnllgunmn wirdn
includes optians for solver, ingut feature
chaice, regularization functions to avaid
overfitiing, &

Seoner. Calculates 3 number of performance

measires such as accurs

Gohen's Kappa, toquanilly e ity of
sifier

Mumerie Scorer: Calculates a number of

numerical error measures. such 3 100t mean

error, mean sbsolute erag of A2, 1

qm:’mlym quality of & numerical predictor
el

Curve: Displays the Receiver Dpersting
Charseteristic (ROC) curve-of a classifier
werking en a bingry ciass prablem. One of

aﬁ; ai;aﬁs ﬁji

the two classes i arbitrarlly chosen as the
okt class and the AOC curve is built on
obaslties/3cares produced fof thet
clach on th ingut data
Integrations 10 many open source data analytics tools are
sl avalsble. Some uze the KHIE node GUI (420, Wak,
Spark MLIB). Others offer h i
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